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Utilities

Tools Depot
Tools Depot allows access to most Cisco Unity tools from a single location. The Cisco Unity Tools 
Depot icon is available on the Cisco Unity server desktop.

The left pane of the Tools Depot window lists all available tools by category. To display online Help for 
a tool, click the name in the left pane. To run the tool, double-click the name.

Some tools work only with selected versions of Cisco Unity. If a tool does not appear in the Tools Depot, 
it does not work with the version of Cisco Unity currently running.

For more information on the following tools, see the related sections.

Integration Monitor
The Integration Monitor shows the information being sent between the phone system and Cisco Unity. 
Each packet of data contains information on one call that the phone system forwards to Cisco Unity. In 
some cases, seeing this data can help you diagnose integration problems.

With a serial integration, you can view the packets of data that are sent over the serial link. The 
Integration Monitor also displays the packets that Cisco Unity sends to the phone system, each of which 
contains one MWI on or off code.

The Integration Monitor Shows the information being sent between the phone system and Cisco Unity. 
See the “Integration Monitor” section on page 10-1.

Learn Tones Learns the frequency and cadence of the phone system tones and updates the 
phone system template file. See the “Learn Tones” section on page 10-5.

The Call Viewer Displays information about each call that the phone system integration sends 
to Cisco Unity. See the “Call Viewer” section on page 10-10.

The Cisco Unity 
Diagnostic Tool

Contains a database of possible Cisco Unity problems and controls the 
gathering of diagnostic traces used to troubleshoot these problems. See the 
“Cisco Unity Diagnostic Tool” section on page 10-10.

Advanced Settings Tool Allows updating of hidden registry settings and addition of new registry keys. 
See the “Advanced Settings Tool” section on page 10-12.

The Universal Dialogic 
Diagnostics utility 

Performs a wide range of tests on the Dialogic voice cards. See the “Universal 
Dialogic Diagnostics Utility” section on page 10-14.
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With an DTMF (analog) integration, you can view the packets sent over the analog phone lines that 
connect the phone system and Cisco Unity.

When troubleshooting IP integrations (such as Cisco CallManager or SIP), use the Call Viewer. The 
Cisco Unity Integration Monitor is not compatible with IP integrations. See the “Call Viewer” section 
on page 10-10 for more information.

To run the Integration Monitor

Step 1 Cisco Unity must be running for the Integration Monitor to display the packets being passed to and from 
the Cisco Unity server. If Cisco Unity is not running, start it.

Step 2 On the Cisco Unity server desktop, double-click the Cisco Unity Tools Depot icon.

Step 3 In the left pane of the Tools Depot window, in the Switch Integration Tools directory, double-click 
Integration Monitor.

Step 4 Use the View menu to select display options. For more information, see the “Integration Monitor Display 
Options” section on page 10-3.

Values Displayed in the Integration Monitor
For information on the values and menu options that appear in the Integration Monitor, see Table 10-1.

 
Table 10-1 Integration Monitor Fields and Columns

Field/Column Meaning

Analog Integration or 
Serial Integration

Immediately below the menu bar, the Integration Monitor displays the name of the current integration 
and the integration type.

First Digit Delay (ms)

(DTMF or analog 
integrations only)

The amount of time that Cisco Unity waits (in milliseconds) for the first digit of a packet to arrive 
after Cisco Unity answers a call. For example, to specify that the Integration Monitor wait three 
seconds for the first digit to arrive, enter 3000.

If you change this value, you are changing the value in the Cisco Unity phone system template file 
for the current integration. Changing this value may cause Cisco Unity to work incorrectly.

Next Digit Delay (ms)

(DTMF or analog 
integrations only)

The amount of time that Cisco Unity waits between digits for the next digit of a packet to arrive. If 
the next digit does not arrive within that amount of time, Cisco Unity considers the next digit user 
input, and the Integration Monitor displays the digit on a new line (only when the Include digits 
option and Hang-up packet are defined). For example, to specify that the Integration Monitor wait 
two-tenths of a second for the next digit to arrive, enter 200.

If you change this value, you are changing the value in the Cisco Unity phone system template file 
for the current integration. Changing this value may cause Cisco Unity to work incorrectly.

Time The time at which Cisco Unity received the call from the phone system or the time at which 
Cisco Unity sent an MWI on or off code to the phone system. New packets appear at the top of the 
Integration Events list.

Packet The unformatted information that the phone system sent to Cisco Unity or that Cisco Unity sent to 
the phone system. The Integration Monitor uses the phone system template file to parse the contents 
of the packet into the values in the remaining columns.

Port The voice card port on the Cisco Unity server on which a call arrives from the phone system.
10-2
Cisco Unity Troubleshooting Guide (With IBM Lotus Domino)

OL-3101-01



Chapter 10 Utilities
Integration Monitor
Integration Monitor Display Options
The menus in the Integration Monitor allow you to save data to a file and change the display in a variety 
of ways, as described in Table 10-2.

Table 10-2 Integration Monitor Options

Menu Option Description

File Log to file To specify a file for saving Integration Monitor data.

Edit Allow delay edits

(DTMF or analog 
integrations only)

To change the values in the First Digit Delay (ms) and Next Digit Delay (ms) fields. 
If this option is not selected, the values are display only. For more information, see 
First Digit Delay (ms) and Next Digit Delay (ms) in Table 10-1.

View Always on top To display the Integration Monitor window in front of all other windows regardless of 
which window is currently active.

To cancel the option, click it again.

View Include digits

(DTMF or analog 
integrations only)

To display individual digits that are not recognized as part of a packet. For more 
information, see Next Digit Delay (ms) in Table 10-1.

View Freeze display To prevent new data packets from being displayed in the Integration Monitor window. 
If Cisco Unity is busy, this option can be useful for analyzing an individual packet. 
Freezing the display prevents the packet from scrolling out of the window before you 
can look at it.

To unfreeze the display, click the option again.

View Raw serial data

(serial integrations only)

To display data from the phone system or from Cisco Unity regardless of whether the 
Integration Monitor recognizes the data as a valid packet. If no data is displayed in 
the Integration Monitor but you think it should be, try this option. There may be no 
display because the Integration Monitor is unable to determine what the pieces of the 
packets are.

To return to displaying formatted packets, click the option again.

View Outgoing data

(serial integrations only)

To display only the packets that Cisco Unity is sending to the phone system to turn 
MWIs on and off.

To return to displaying all packets, click the option again.

View Incoming data only

(serial integrations only)

To display only the packets that the phone system is sending to Cisco Unity, 
including:

• Calls forwarded to Cisco Unity because the extension is busy.

• Calls forwarded to Cisco Unity because the extension is not answered.

• Calls forwarded to Cisco Unity because the extension is in do not disturb mode.

• Calls from subscribers who want to check or leave voice messages.

• Calls from external callers who called Cisco Unity.

To return to displaying all packets, click the option again.
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Frequently Asked Questions About the Integration Monitor

Integration Monitor Troubleshooting

To resolve a situation where no integration information is displayed for a serial or DTMF integration

Step 1 In the View menu, confirm that Freeze Display is not selected. If it is selected, deselect it.

Step 2 On the Cisco Unity server, browse to the CommServer\Utilities\Utim directory and double-click 
Utim.exe. The Cisco Unity Telephony Integration Manager (UTIM) appears.

Step 3 Confirm that the settings match those indicated in the integration guide for your phone system.

Step 4 Correct any incorrect values.

Step 5 If you changed values in Step 4, click Save, and continue with Step 6. If you did not change any values, 
skip to Step 7.

Step 6 If prompted, restart the Cisco Unity server.

Step 7 If you have a serial integration, confirm that the serial cable is plugged securely into the correct 
Cisco Unity COM port and into the phone system serial port.

If none of the steps in this procedure correct the problem, contact the Cisco Technical Assistance Center 
(TAC).

To resolve a situation where only partial packets appear (DTMF or analog integrations only)

Step 1 On the Integration Monitor Edit menu, click Allow Delay Edits.

Step 2 Increase the values in the First Digit Delay (ms) and Next Digit Delay (ms) fields. For example, if the 
First Digit Delay (ms) field is set to 2000, change it to 3000. And if the Next Digit Delay (ms) field is 
set to 250, change it to 500.

Step 3 On the Integration Monitor Edit menu, click Allow Delay Edits again to save the changes.

Question Answer

Can I freeze the display? Yes. From the View menu, click Freeze Display.

Can I view raw serial data? Yes. From the View menu, click Raw Serial Data.

Can I view DTMF digits 
(analog only) separately from 
the packets?

Yes. From the View menu, click Include Digits, and confirm that the 
Hang-up packet is defined. This view lets you see all packets and all 
other DTMF digits detected by Cisco Unity and can be helpful in 
troubleshooting DTMF integration packet problems.

Can I log the integration 
packets in the Integration 
Monitor to a file?

Yes. From the File menu, click Log to File. Specify name and location 
of the file to receive the integration packet information.

Can the Integration Monitor 
be used with all integrations?

No. The Integration Monitor can be used only for serial and DTMF 
(analog) integrations. For IP integrations (such as Cisco CallManager 
and SIP), use the Call Viewer. See the “Call Viewer” section on 
page 10-10 for more information.
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Step 4 If partial packets still appear, contact Cisco TAC for assistance in changing the OffHook delay 
parameter.

Learn Tones
Cisco Unity comes with template files for a variety of phone systems. These template files usually work 
without modification. However, problems with transfers, message waiting indicators (MWIs), and 
message notification can arise if Cisco Unity does not understand the phone system tones. If any of these 
problems occur, and basic troubleshooting procedures do not correct the problem, run the Learn Tones 
utility to modify the phone system template file.

The Learn Tones utility is designed to run on systems equipped with Dialogic analog voice cards only. 
The Learn Tones utility also requires exclusive access to the ports. Do not run Learn Tones unless 
Cisco Unity is shut down.

The Learn Tones utility learns the frequency and cadence of the phone system tones, such as busy and 
ringback, and teaches them to Cisco Unity. Once you start the utility, the process is automatic. One voice 
messaging port calls other ports to generate the tones. The utility displays the tone settings already 
present in the phone system template file on start-up, and sets any missing items to the default values. 
Upon completion, it adds the learned tones of your choice to the phone system template file.

Tones Defined in the Switch Configuration File
There are five different tones that can be defined in the Cisco Unity switch configuration file. These can 
be split into two categories. The first category is tones that are used during call progress. Cisco Unity 
listens for these tones when performing a transfer or making an outgoing call, but does not listen for 
these tones during the voice mail conversation or during recording. These tones are:

• Switch Dial Tone

• Switch Ringback Tone

• Switch Busy Tone

The other two tones are disconnect tones. Cisco Unity always listens for these tones during voice 
messaging conversation and during recording. If one of these tones is detected, it tells Cisco Unity that 
the caller has hung up, and Cisco Unity goes on hook. These tones are:

• Switch Disconnect Tone

• CO Disconnect Tone

There are usually no tone definitions in the switch configuration file when the Cisco Unity system is 
installed. Depending on the phone system and integration being used, it is often unnecessary to define 
any tones in the switch configuration file. Cisco Unity uses a default set of definitions for tones that are 
not defined in the switch configuration file, and this default set usually works. When it is determined 
that a particular tone (or tones) must be defined in the switch configuration file, it is best to define only 
that tone. Defining tones that are not necessary for Cisco Unity to perform properly with a particular 
phone system can limit the ability of the voice messaging system to handle unexpected tones, such as 
unexpected disconnect tones sent from a PSTN.

Learning tones may resolve the problem when callers report being disconnected (hung up on) while they 
are recording a voice message. The default disconnect tone definitions in Cisco Unity have very large 
frequency and cadence deviations defined. While this allows the system to detect disconnect tones from 
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a wide range of central offices, phone systems, countries, and so on, it also increases the chance that the 
voice of a caller will mistakenly be detected as disconnect tone, causing the voice messaging system to 
hang up on the call. Learning the disconnect tones specific to the phone system in use can remedy this 
problem. Once the tone definition is in the switch configuration file, the deviations can be manually 
edited if fine tuning is desired.

Switch Configuration File Location
The switch configuration.ini files are located in the \CommServer\Intlib folder on the Cisco Unity server. 
The active switch configuration file is based on the selections made in the UTIM during Cisco Unity 
installation, or by any subsequent changes made in the Edit Switch utility.

Running the Learn Tones Utility
Do the following procedure to run the Learn Tones utility.

To run the Learn Tones utility (on systems equipped with Dialogic analog cards only)

Step 1 Shut down the Cisco Unity software.

Step 2 On the Cisco Unity server desktop, double-click the Cisco Unity Tools Depot icon.

Step 3 In the left pane of the Tools Depot window, in the Switch Integration Tools directory, double-click Learn 
Tones.

Step 4 Confirm that all ports and extensions are correct. Do not use a hunt group for the helper extension.

Step 5 Choose Manual mode or allow Learn Tones to run in Automatic (default) mode.

Both modes use port 1 as the primary learning port, and Automatic mode uses ports 2 and 3 as helper 
ports. Or, you can designate other helper ports by entering their port numbers and extensions. Extension 
numbers for ports 1, 2, and 3 are imported automatically from the Cisco Unity Administrator Ports page.

Use Manual mode when you want the primary port to call a specific extension rather than a helper port, 
or when some aspect of the phone system programming, such as forwarding when a line is busy, conflicts 
with the tone-learning process. The phone specified for Manual mode should be close to the Cisco Unity 
server, so that you can see the on-screen prompts and operate the phone at the same time. To run in 
Manual mode, check the Manual Mode check box under Settings, and enter the extension of the phone 
you want to use in the Manual Ext field.

Step 6 Confirm that the Delay Between Calls field is set to the default value of 4000 ms. Delay between calls 
is the number of milliseconds that Learn Tones delays before making a subsequent call to learn or verify 
a tone.

Step 7 Confirm that the Deviation Threshold field is set to the default value of 15 percent. The Deviation 
Threshold field sets the deviation that is considered acceptable when learning individual tones. Tones 
outside the Deviation Threshold field setting for any single field (frequency 1, frequency 2, on, off, and 
so on) are discarded.

Step 8 Confirm that the Calls field is set to the default value of 1.

Step 9 Confirm that the Frames field is set to the default value of 5.

Step 10 Confirm that the Delay(ms) field is set to the default value of 1500ms. The Delay field sets the amount 
of time between the completion of the action to cause a tone, and the beginning of learning the tone. The 
delay value avoids detection of stray events on the line during line state transitions.
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Step 11 To learn dial tone, in the Dialtone section, click Learn. In Automatic mode, Learn Tones uses the 
following process to learn dial tone:

a. Goes off-hook on port 1.

b. Waits the number of milliseconds defined in the Delay field for dial tone.

c. Listens to and learns the tone on port 1.

d. Goes on-hook on port 1.

e. Waits the number of milliseconds defined in the Delay Between Calls field.

f. Listens to and verifies the tone on port 1.

g. Goes on-hook on port 1.

If a “Success” message appears at the conclusion of this process, continue with Step 12.

If a “Failure” message appears, resolve the problem and repeat this step.

Step 12 To learn busy tones, in the Busy section, click Learn. In Automatic mode, Learn Tones follows this 
process to learn busy tone:

a. Goes off-hook on port 2.

b. Dials port 3 extension.

c. Goes off-hook on port 3 to answer the call from port 2.

d. Goes off-hook on port 1.

e. Dials port 2 extension.

f. Waits the number of milliseconds defined in the Delay field for busy tone.

g. Listens to and learns the tone on port 1.

h. Goes on-hook on ports 1, 2, and 3.

i. Waits the number of milliseconds defined in the Delay Between Calls field.

j. Goes off-hook on port 2.

k. Dials port 3 extension.

l. Goes off-hook on port 3 to answer the call from port 2.

m. Goes off-hook on port 1.

n. Dials the extension of port 2.

o. Listens to and verifies the tone on port 1.

p. Goes on-hook on ports 1,2 and 3.

If a “Success” message appears, continue with Step 13.

If a “Failure” message appears, resolve the problem and repeat this step.

Step 13 To learn the phone system disconnect tone, in the Disconnect section, click Learn. In Automatic mode, 
Learn Tones follows this process to learn disconnect tone:

a. Waits the amount of milliseconds defined in the Delay Between Calls field.

b. Goes off-hook on port 1.

c. Dials port 2 extension.

d. Goes off-hook on port 2 to answer the call from port 1.

e. Delays for 2000ms (2 seconds).
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f. Goes on-hook on port 2.

g. Waits the amount of milliseconds defined in the Delay field for disconnect tone.

h. Listens to and learns the tone on port 1.

i. Goes on-hook on port 1.

j. Waits the amount of milliseconds defined in the Delay Between Calls field.

k. Goes off-hook on port 1.

l. Dials port 2 extension.

m. Goes off-hook on port 2 to answer the call from port 1.

n. Delays for 2000ms (2 seconds).

o. Goes on-hook on port 2.

p. Listens to and verifies the tone on port 1.

q. Goes on-hook on port 1.

If a “Success” message appears, continue with Step 14.

If a “Failure” message appears, resolve the problem and repeat this step.

Step 14 To learn CO Disconnect tone, in the CO Disconnect section, click Learn. In Automatic mode, Learn 
Tones uses the following steps to learn CO disconnect tone:

a. Goes off hook on port 1.

b. Dials 9.

c. Waits the amount of milliseconds defined in the Delay field for CO Disconnect tone.

d. Listens to and learns the tone on port 1.

e. Goes on-hook on port 1.

f. Waits the amount of milliseconds defined in the Delay Between Calls field.

g. Goes off-hook on port 1.

h. Dials 9.

i. Listens to and verifies the tone on port 1.

j. Goes on hook on port 1.

If a “Success” message appears, continue with Step 15.

If a “Failure” message appears, resolve the problem and repeat this step.

Step 15 To learn ringback tone, in the Ringback section, click Learn. In Automatic mode, Learn Tones uses the 
following steps to learn ringback tone:

a. Goes off-hook on port 1.

b. Dials the extension of port 2.

c. Waits the amount of milliseconds defined in the Delay field for ringback tone.

d. Listens to and learns the tone on port 1.

e. Goes on hook on port 1.

f. Waits the amount of milliseconds defined in the Delay Between Calls field.

g. Goes off-hook on port 1.

h. Dials the extension of port 2.
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i. Listens to and verifies the tone on port 1.

j. Goes on hook on port 1.

If a “Success” message appears, continue with Step 16.

If a “Failure” message appears, resolve the problem and repeat this step.

Step 16 The Learn Tones utility automatically verifies tones after it learns them, so there is no need to click the 
Verify All button before saving the learned tones.

Step 17 Click Save.

Step 18 In the dialog box that appears, check only the boxes of the tones you want to update in the switch 
configuration file, then click OK.

Step 19 To save the new tones directly to the active switch configuration file, accept the default file name. If you 
want to save the tones to a temporary file for comparison and then manually copy them to the switch 
configuration file at a later time, enter a file name of your choice. Click Open.

Step 20 Click Done to exit the Learn Tones utility.

Step 21 Restart the Cisco Unity software.

Troubleshooting the Learn Tones Utility
If the learn tones process fails, do one or more of the following actions:

• Adjust the setting in the Delay field for the tone that you are having trouble with. 1500 to 2000 
milliseconds is usually sufficient. Be careful not to make this delay too long as Learn Tones may fail 
to learn a tone, learn the wrong tone, or miss the tone altogether.

• If Automatic mode is not working, try Manual mode, or vice versa.

• Unplug the line cord from port 1 of Cisco Unity and plug it into an analog phone. Use the same steps 
that the Learn Tones utility uses to manually recreate the condition that Learn Tones is listening to.

• If one or more tones are learned with the following cadence.

the learned tone is continuous. When a tone with continuous cadence is saved to the switch 
configuration file, the cadence appears as:

TimeOn1=4000
TimeOnDeviation1=0
TimeOff1=0
TimeOffDeviation1=0
Cycles=0

This is intentional. To support voice card manufacturers other than Dialogic, the latter method must 
be used when defining a continuous tone in the switch configuration file. When Cisco Unity is 
restarted, the Miu translates the cadence back to the original settings if Dialogic cards are installed.

• If you need assistance resolving these or other Learn Tones problems, contact Cisco TAC.

On(ms) Dev Off(ms) Dev

2000 –2000 0 0
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Call Viewer
For each call that the phone system integration sends to Cisco Unity, the Call Viewer displays one line 
of information. This information can be helpful when troubleshooting problems with the phone system 
integration, as well as testing call routing rules.

The Call Viewer displays integration information for inbound calls only. To see call information for 
outbound calls, use the StatusMonitor, located in the Tech Tools directory.

Note that if you are troubleshooting a Cisco CallManager integration, you must use the Call Viewer; the 
Cisco Unity Integration Monitor is not compatible with a Cisco CallManager integration.

To run the Call Viewer

Step 1 If Cisco Unity is not running, start it.

Step 2 On the Cisco Unity server desktop, double-click the Cisco Unity Tools Depot icon.

Step 3 In the left pane of the Tools Depot window, in the Switch Integration Tools directory, double-click Call 
Viewer.

Step 4 Use the Call Viewer window to see call information that the phone system integration provides to 
Cisco Unity for inbound calls.

Cisco Unity Diagnostic Tool
The Cisco Unity Diagnostic Tool allows creating and viewing of diagnostic log files to troubleshoot 
problems. It replaces the diagnostic log functionality in Maestro Tools, and allows the system 
administrator or TAC staff to selectively run diagnostic traces at two levels:

• Macro Traces—These are collections of component traces that help diagnose problems such as 
message waiting indicator and system problems.

• Micro Traces—These are the component traces. Each component has up to 32 trace levels that can 
be individually selected.

The Cisco Unity Diagnostic Tool also allows the system administrator or TAC staff to perform the 
following tasks:

• Create new log files on demand. This makes troubleshooting problems easier. When a problem can 
be reproduced reliably, the system administrator can close all existing log files and create new log 
files prior to reproducing the problem. This eliminates many unnecessary and unrelated items from 
the logs.

• Configure log settings. The system administrator can adjust the maximum disk space allowed for all 
diagnostic log files. (The default setting is 400 MB.) The Logging Properties screen also allows the 
system administrator to disable all diagnostic output by clearing the Diagnostic Output check box.

• Gather standard logs. This option provides the ability to quickly gather all or selected Microsoft 
Windows and Cisco Unity logs.

• Disable all traces. This is a quick way to return diagnostic logs to their default settings after 
troubleshooting efforts are complete.

• View the Event log. The Event log files for either the local computer or another computer can be 
viewed and exported.
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• Change the display language for Windows Event log messages that are generated by Cisco Unity. 
This is a temporary change and is only in effect while the Cisco Unity Diagnostic Tool is running.

To view and export diagnostic files by using the Cisco Unity Diagnostic Tool

Step 1 On the Cisco Unity server desktop, double-click the Cisco Unity Tools Depot icon.

Step 2 In the left pane of the Tools Depot window, in the Diagnostic Tools directory, double-click Unity 
Diagnostic Tool.

Step 3 On the left pane of the Cisco Unity Diagnostic Viewer screen, click Processes. The node expands to list 
each process that uses log manager.

Step 4 Click a process node and then click a log file. The selected log file is formatted and displayed in the right 
pane.

Step 5 To export or save a copy of the log file, click Action > Export List.

Step 6 Name the file and save it to a location of your choice in .txt or .csv format.

To create macro or micro diagnostic traces for troubleshooting

Step 1 On the Cisco Unity server desktop, double-click the Cisco Unity Tools Depot icon.

Step 2 In the left pane of the Tools Depot window, in the Diagnostic Tools directory, double-click Unity 
Diagnostic Tool.

Step 3 On the Cisco Unity Diagnostic Viewer screen, click either the Configure Macro Traces icon, or the 
Configure Micro Traces icon, as applicable.

Step 4 Follow the wizard on-screen instructions.

Step 5 On the Cisco Unity Diagnostic Viewer screen, click Start New Log Files.

Step 6 Reproduce the problem.

Step 7 View and export the results by doing the procedure, To view and export diagnostic files by using the 
Cisco Unity Diagnostic Tool, page 10-11.

Step 8 On the Cisco Unity Diagnostic Viewer screen, click the Disable All Traces icon to turn off the traces set 
in Step 3.

Step 9 In the Disable All Traces Wizard screen, check the Disable All Traces check box, and click Finish.

To access the Event Viewer on another computer

Step 1 In the left pane of the Cisco Unity Diagnostic Tool window, right-click Event Viewer (Local).

Step 2 Click Connect to Another Computer.

Step 3 Browse to select a computer from the list.

Step 4 Click OK.

Step 5 Select and view the log file.

Step 6 To export or save a copy of the log file, click Action > Export List. 
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Step 7 Name the file and save it to a location of your choice in .txt or .csv format.

To change the Windows Event log display language for Cisco Unity-generated messages

Step 1 On the Cisco Unity server desktop, double-click the Cisco Unity Tools Depot icon.

Step 2 In the left pane of the Tools Depot window, in the Diagnostic Tools directory, double-click Unity 
Diagnostic Tool.

Step 3 In the left pane of the Cisco Unity Diagnostic Tool, click Cisco Unity Diagnostic Tool > Processes. The 
node expands to list each process that uses log manager.

Step 4 Right-click Processes or the individual process node of your choice.

Step 5 Click Change Cisco Unity Event Log Language.

Step 6 Click a new language from the list of available languages.

Step 7 Click Apply, then click OK.

Step 8 In the left pane of the Cisco Unity Diagnostic Tool, click Event Viewer (Local), and then click the log 
file category you wish to view.

When the Cisco Unity Diagnostic Tool is closed, Cisco Unity Event log messages revert to the original 
language.

Advanced Settings Tool
The Advanced Settings Tool allows system administrators to safely edit many of the Cisco Unity hidden 
registry settings. It gives a brief overview of each setting, limits edits to specific value ranges, and 
ensures that edits are consistent with the installed Cisco Unity version.

Note A typical backup of the Cisco Unity server does not back up the registry. 

To edit an existing registry key

Step 1 On the Cisco Unity server desktop, double-click the Cisco Unity Tools Depot icon.

Step 2 In the left pane, under Administrative Tools, double-click Advanced Settings Tool.

Step 3 In the Unity Settings pane, click the key name.

Step 4 In the New Value box or list, click or enter the appropriate value, then click Set.

Step 5 When prompted, click OK.

Step 6 Click Exit.

Step 7 If applicable, restart the Cisco Unity server for the registry change to take effect.
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To add a new registry key

Adding a new registry key to the database should be done only when indicated in the Cisco Unity 
documentation, or on the advice of Cisco TAC. Note that the add function can also be used to display 
information about existing registry settings.

Step 1 Open a command prompt window, and browse to the CommServer\Utilities\Advanced Settings Tool 
directory.

Step 2 Enter start unityadvancedsettingstool /addkey and press Enter. The Unity Advanced Settings page 
appears.

Step 3 On the Unity Advanced Settings page, click Add New Key.

Step 4 On the Add New Registry Key page, click Add New. Enter information in the following fields as 
applicable.

 

Field Name Description

Index Display only. A read-only field that displays a unique number for each record 
in the database.

Short Description Enter a description of the registry key change (maximum of 250 characters).

Long Description Enter a description of the behavior change that the registry key invokes.

Key Path Enter the path to the directory where the key is stored. All values are assumed 
to be under HKEY_LOCAL_MACHINE.

If you need to set values outside of this registry branch, do not use this tool. Use 
Regedit instead.

Key Name Enter the name of the registry at the key path. In the rare case of a registry 
setting that is only the key path and not a key value, you can leave this field 
blank.

Key Type Select a value from the drop down list, as follows:

• REG_SZ—string values.

• REG_DWORD—number values.

• REG_BINARY—binary values (not used).

• NONE—for cases where the presence of the key path is all that is needed, 
rather than a key with a value. This value should be used rarely, if at all.

Minimum Value Enter the minimum allowable value, if the key type is a number. String values 
do not use this field.

Maximum Value Enter the maximum allowable value, if the key type is a number. String values 
do not use this field.

Step By Enter the step for each value added to the drop down list, if the key type is a 
number. For example, if the minimum value is 0, and the maximum value is 
100, a step by value of 20 will populate the drop down list with 0, 20, 40, 60, 
80, 100.

Minimum Unity 
Version

A list of all Cisco Unity versions 2.3 and later. Indicate if the registry key is not 
valid for versions earlier than a specified version.

Maximum Unity 
Version

A list of all Cisco Unity versions 2.3 and later. Indicate if the registry key is not 
valid for versions later than a specified version.
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Step 5 Click Save, and then click OK.

Step 6 Click Exit.

Universal Dialogic Diagnostics Utility
The Universal Dialogic Diagnostics (UDD) utility performs a wide range of tests on the Dialogic voice 
cards. It is used to determine if something is wrong with one or more of the Dialogic voice cards in the 
Cisco Unity server.

To run the UDD utility

Step 1 On the Windows Start menu, click Programs > Dialogic System Software > Universal Dialogic 
Diagnostics Utility.

Step 2 On the Service menu, click Stop Service.

Step 3 The UDD utility may display several warning or error messages. For each, choose the option that 
continues the process of starting the utility.

Step 4 Select the options required to perform all tests on all voice cards. The tests take approximately five 
minutes per voice card.

Step 5 When the tests are finished, the Done button becomes available. Click Done to display additional 
information on failed tests, if any.

Step 6 If you see errors that you do not know how to resolve, contact Cisco TAC.

Step 7 When you are finished reviewing test results, click Exit UDD.

Step 8 Shut down and restart the Cisco Unity server.

Status Monitor
Cisco Unity has two Status Monitors: the web-based Status Monitor that is described in the Cisco Unity 
System Administration Guide, and StatusMonitor.exe located in the Switch Integration Tools directory 
of Tools Depot. 

Both are useful as troubleshooting tools; however, the web-based Status Monitor is not intended to be 
run for long periods of time due to the significant amount of system resources it utilizes. The web-based 
Status Monitor automatically times out after 20 minutes of use while the StatusMonitor.exe does not 
adversely impact system performance and can be run for as long as necessary to monitor call activity 
and troubleshoot a problem.

StatusMonitor.exe is useful for testing and troubleshooting integration issues with a Cisco CallManager 
integration, including call handlers, conversations, message waiting indicators, and notification calls. It 
displays information for both inbound and outbound calls, and can work remotely with Windows 
Terminal Services. 
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To use StatusMonitor.exe

Step 1 On the Cisco Unity server desktop, double-click the Cisco Unity Tools Depot icon.

Step 2 In the left pane of the Tools Depot window, in the Switch Integration Tools directory, double-click 
Status Monitor.

Step 3 On the Status Monitor page, choose from the following options according to your testing and 
troubleshooting needs. When a monitor is started, the state shown is controlled by the Monitor Settings 
When Started selection: Application, Display, or Conversation.

Step 4 Use the Print Screen function on the workstation or server to copy or save the displayed data for later 
reference, if needed.

Step 5 Click Cancel to close the Status Monitor window.

Window Element Function

Start Monitor Starts the monitor for the port selected in the left pane.

Start All Monitors Starts the monitor for all ports.

Stop Monitor Stops the monitor.

Stop All Monitors Stops the monitor for all ports.

Tile Monitors Sets the display format.

Cascade Monitors Sets the display format.

Monitor Settings When 
Started: Application

Shows the state of the Cisco Unity application during the monitoring session. 
States include Idle, Attempt Sign-in, Transfer, Greeting, etc.

Monitor Settings When 
Started: Display

Shows a high-level overview of activity during the monitoring session 
including Dial, MWI (with extension), Notification (with extension), etc.

Monitor Settings When 
Started: Conversation

Shows detailed events that occur during the monitoring session. Events 
include Call Handlers in use, Action by Subscribers, Greetings, DTMF, etc.

Show Port Availability Shows the registry setting (in hex.) 

Tip: use the Ports page in the Cisco Unity Administrator for this function.

Place Call Do not use. Place the test call from a nearby phone.

Show New Calls Displays the call origin and other information useful for testing routing rules. 
You can also use the Call Viewer to obtain this information.

Set MWI Do not use. To test an MWI, leave a message from a nearby phone.

Reset Port Disconnects any active calls on the selected port.

Busy Port Disables the selected port, placing it in an RNA (ring no answer) state.

Disable Port Do not use. This function is not currently available.
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